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Legal and Regulatory Notices 
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Table of Changes 

Version  Date  Changes  Remarks 
2.0 2000-10-14 Software versions:   

BioTools, Version 2.0  
SequenceEditor, Version 1.0 

 

2.1 2002-01-18 Software versions:   
BioTools, Version 2.1  
SequenceEditor, Version 2.1 

 

2.2 2002-08-01 Software versions:   
BioTools, Version 2.2  
SequenceEditor, Version 2.1 

 

3.0 2005-05-12 Software versions:   
BioTools, Version 3.0  
SequenceEditor, Version 3.0 

 

3.1 2007-01-26 Software versions:   
BioTools, Version 3.1  
SequenceEditor, Version 3.1 

 

3.2 2008-10-28 Software versions:   
BioTools, Version 3.2  
SequenceEditor, Version 3.2 

 

3.2 SR1 2010-03-15 Software versions:   
BioTools, Version 3.2 SR1  
SequenceEditor, Version 3.2 SR1 

 

3.2 SR2 2011-05-15 Software versions:   
BioTools, Version 3.2 SR2  
SequenceEditor, Version 3.2 SR2 

 

3.2 SR3 2011-11-15 Software versions:   
BioTools, Version 3.2 SR3  
SequenceEditor, Version 3.2 SR3 

 

3.2 SR4 2012-12-10 Software versions:   
BioTools, Version 3.2 SR4  
SequenceEditor, Version 3.2 SR4 

 

3.2 SR5 2015-08-31 Software versions:   
BioTools, Version 3.2 SR5  
SequenceEditor, Version 3.2 SR5 
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1 INSTALLATION 

1.1 System Requirements 

• CPU: Intel Pentium III processor or better. 
• Clock: 1 GHz processor for satisfying data handling. 
• Main Memory: Minimum 512 Mbytes RAM or better. 
• Operating systems supported:  

o Microsoft Windows Vista Business Edition, Service Pack 1, 32 bit 
o Microsoft Windows 7, Business Edition, 32 and 64 bit 

• Internet Explorer 8.0 or better 
• Graphic Resolution: 1024 x 768 pixel, 256 colors or better 
• CD-ROM drive (4x or better) 
• Ethernet connection  
• Hard disk: at least 1 Gigabyte of free disk space. 
 
 
1.2 Backup Methods 

a. If no backup folder exists on the BioTools computer, create one. We 
recommend a location like D:\Bruker_Service 

b. Create a subfolder for the actual backup. We recommend coding your current 
date, e.g. \backup_ddmmyy (dd=day, …) 

c. If you’re upgrading from a 2.x version of BioTools, browse to the BioTools 
installation directory, (usually this is C:\Bruker\BioTools) and copy the file 
batch.ptr to the newly created directory (necessary for old method import after 
the de-installation). When upgrading from BioTools 3.0 this step is not 
necessary, 3.0 methods can be read by BioTools 3.2. 

d. Save the URL of your local Mascot Server. It can be found on the MS ( ) or 
MSMS Mascot Search dialog ( ) or the Batch Mode window (Query parameter 
tab). 

e. You may backup these directories from the method folder: 
D:\Methods\BiotoolsParamFiles and D:\Methods\SEDigestMethods if you have 
defined building blocks, crosslinks or enzymes using a previous version of 
BioTools. 
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1.3 Uninstall old BioTools version 

a. Make sure that you are logged on as Administrator or with administrator 
privileges, uninstall and install will not work with restricted user rights. 

b. Go to the Windows Start menu → Settings → Control Panel and choose 
"Add/Remove Programs". 

c. Choose BioTools and remove it from the system. 

d. If there is a BioTools icon left on the desktop, remove it. 

 
 
1.4 Install BioTools 

a. Put the BioTools installation CD in the CD-ROM drive, wait for the launcher 
interface and choose "Install". 

If the launcher interface does not open automatically, choose "CD_Start.exe" 
from the BioTools CD. 

 

 
Figure 1-1 Choosing "Install" 
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b. To view the installation instructions click on "Installation Instructions".  
 

 

Follow the instructions on the screen to install the BioTools and the Perl Scripts 
(optionally).  

c. Start the installation with a click on "BioTools" (or run the "CD_Start.exe" from 
the BioTools CD). 

 

Figure 1-2 Choosing "Installation Instructions" 

Figure 1-3 Choosing "BioTools" 
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d. If the following message appears, an old version of BioTools is still installed on 
the system.  

 

 Click "OK" and remove the old version with the Windows "Add/Remove 
Programs" feature. 

 
e. Go back to the BioTools launcher interface and start the installation again. 

Nearly always choose the preset options and confirm the following dialogs. 

 Click "Next" to start the installation 

 

Figure 1-4 Message about old BioTools version found 

Figure 1-5 Installation started 
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f. Accept the License Agreement. 

 

g. Choose the installation directory. 

Figure 1-6 Accepting License Agreement 

 
Figure 1-7 Choosing installation directory 
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h. You may be prompted to select a directory for the tutorial data that come with 
the installation. The selected folder will be used by other Bruker programs 
installed subsequently on that machine. A similar dialog prompting for the 
method directory may also appear. 

i. Select the check box to add desktop icons. 

 
Figure 1-8 Selecting data folder 

 
Figure 1-9 Choosing setup type and creation of desktop icons 
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j. Install the software by clicking on "Install". 

k. A progress indicator shows the status of the installation. 

 
Figure 1-10 Starting installation by clicking "Install" 

 
Figure 1-11 Installation running 
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l. If BioTools 3.2 is installed the first time on this computer, a 60-days license is 
created:  

Do not forget to enter your permanent license after the installation has been 
finished (menu Compass → License). 

 
m. Click "Finish" to complete the installation. 

 
Figure 1-12 Temporary licenses created 

 

Figure 1-13 Installation finished 
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n. If an outdated version of Mascot is used as in-house server it may be necessary 
to install the Perl scripts by clicking on "Perl Scripts".   
Follow the instructions on the screen to install them. 
 
BioTools 3.2 can be run without installing Perl scripts from the CD when it is 
used with Mascot 2.1 or later. With earlier Mascot versions, make sure that the 
new Perl scripts, coming with the BioTools 3.2 installation CD, are installed on 
the server (!) before a batch mode search is started the first time. Otherwise 
there is no guarantee for correct communication between BioTools and the 
Mascot server (see chapter 1.6 Update Perl Scripts). 

 
o. To leave the installation screen click on "Back".  

 
Figure 1-14 Choosing "Back" 



1 Installation Bruker  

Page 16 of 96 BioTools 3.2  User Manual  Revision F 

p. To view the release notes click on "Release Notes". A new window with the 
release notes will be opened.  

q. To view the contact information click on "Contact".  

 

Figure 1-15 Choosing "Release Notes" 

 
Figure 1-16 Choosing "Contact" 
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r. To close the contact information click on "Back".  

 
s. To leave the launcher click on "Exit".  

 

 
Figure 1-17 Choosing "Back" 

 
Figure 1-18 Choosing "Exit" 
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1.5 Getting Started 

a. Open BioTools 3.2 with a double-click on the desktop icon . 

b. If the Bruker Daltonics Compass Security Pack (CSP) is not installed the 
following dialog appears and asks for an operator name (can be chosen 
arbitrarily). 

Otherwise, if the CSP is installed, the following dialog appears. Please ask your 
Bruker Daltonics CSP administrator for your login and password. Note that 
BioTools 3.2 SR5 needs a license for CSP 1.2 to use CSP 2.0, i.e. BioTools will 
ignore an installed CSP 2.0 if no CSP 1.2 license is available (so both licenses 
need to be added using menu Compass/License..). 

 
Figure 1-19 Login dialog when CSP is not installed 

 
Figure 1-20 Login dialog when CSP is installed 
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c. After BioTools is started, at first the following dialog appears and asks for the 
URL of a possibly available local Mascot server. Click "Now" to enter the URL. 
This is strongly recommended if you want to run Mascot Batch Searches. 

d. In the next dialog click "Edit" and then add the Mascot server address (make 
sure the URL is entered correctly, with a standard Mascot installation only the 
server name needs to be entered in place of ‘Enter Your Server Here’): 

 

 
Figure 1-21 Setting URL of local Mascot server  

 
Figure 1-22 Adding Mascot server address 
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e. To import your old methods from BioTools 2.x open the Batch Mode dialog with 
the button , switch to the "Method/Mail" tab and click the button "Import old 
method". 

f. Browse to the file batch.ptr that you saved in the beginning, probably to the 
directory D:\Bruker_Service and load it. 

g. The methods you worked with in BioTools 2.x are offered in the drop down list.  

Select them, respectively, and choose "Import" to open them in the new method 
editor where they can be saved as BioTools 3.2 methods. 

 

 
Figure 1-23 Choosing "Import old method" 

 
Figure 1-24 Selecting old method for import 
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1.6 Update Perl Scripts 

BioTools 3.2 can be run without installing Perl scripts from the CD when it is used 
with current versions of Mascot (2.1 or later). With earlier Mascot versions, make 
sure that the new Perl scripts, coming with the BioTools 3.2 installation CD, are 
installed on the server (!) before a batch mode search is started the first time. 
Otherwise, there is no guarantee for correct communication between BioTools and 
the Mascot server. 

 
a. Put the BioTools installation CD in the CD-ROM drive, wait for the launcher 

interface and choose "Install". 

If the launcher interface does not open automatically, choose "CD_Start.exe" 
from the BioTools CD 

 

 
Figure 1-25 Choosing "Install" 
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b. Choose "Perl Scripts" and perform the installation as known, fulfill all necessary 
settings.  

 
c. Select Mascot Perl Scripts and change the installation path. 
 
d. After the necessary settings have been done click "Next" and "Install" to finish 

the installation. 

 
Note: If the old Mascot server is installed on a Unix or Linux system, choose 

‘Perl Scripts’ from the launcher interface and copy the offered scripts to 
the directory where the mascot-exe file is already available (probably 
/usr/local/mascot/cgi). Please keep in mind that we do not offer support 
for this.  

 

 
Figure 1-26 Choosing "Perl Scripts" 
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1.7 Starting the Program 

Use the BioTools Icon from the program group you specified during program 
installation. If you receive the error message "A procedure entry point 
httpsendrequestExA could not be located in the dynamic linked library" during program 
start, the Microsoft Internet Explorer 6.0 or better is not installed on your system. The 
installation of the Microsoft Internet Explorer 6.0 or better will replace an existing 
WININET.DLL by a newer one.  

BioTools will be installed with a temporary 60-days license key.  

To avoid the popup, enter your appreciate license key for BioTools delivered be Bruker 
Daltonik GmbH. You will reach the LicenseManager via the menu Compass → 
License.   
 
 
1.8 LicenseManager 

After the 60-days temporary license key has expired you must enter a license key for 
BioTools and optionally for RapiDeNovo. The key(s) comes together with the BioTools 
documentation. Use the license manager to add or remove license keys (menu 
Compass → License).  

If an invalid license key is entered, the program cannot be used.  

 

Figure 1-27 LicenseManager with permanent BioTools 3.2 licenses 
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1.9 Service Information 

We will help you in the Support as precisely as possible. Therefore it is helpful to have 
the following information ready when contacting us: 

 the full version number of the software that causes problems, i.e. version and 
build number (menu Help → About) 

 try to describe exactly what you tried/want to do, or 

 try to describe what happened and/or what you did before the error occurred 

 also screenshots of error messages are highly appreciated 

 

For questions, please contact:  
service.bdal.de@bruker.com  

 

 

 

mailto:service.bdal.de@bruker.com
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2 QUICK GUIDE TO BIOTOOLS 3.2 

2.1 Introduction 

BioTools is a protein analysis package for Bruker Daltonics MALDI and ESI MS 
instruments. 

BioTools work is applied to data (MS- and MS/MS-spectra and peak lists), which were 
previously processed using either flexAnalysis or DataAnalysis. 

 

Figure 2-1 Protein Digests analysis flow  



2 Quick Guide To BioTools 3.2 Bruker 

Page 26 of 96 BioTools 3.2  User Manual  Revision F 

Initial sequence analysis can either occur through protein database searching using 
external search software such as Mascot or through SequenceEditor that allows 
entering the covalent protein structure including modifications and crosslinks in 
BioTools. A sequence assignment can be further enhanced: Additional information like 
creak peaks or modifications can be identified in this process.  
 
 
2.1.1 What is New in BioTools 3.2 and 3.2 SR1-5? 

Get updated on the new features of BioTools 3.2 and BioTools 3.2 SR1-5 in a 
breathtaking PowerPoint presentation "What´s new in BioTools 3.2" that you can 
access via menu Help → What´s new in BioTools 3.2. 
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2.1.2 Application Tutorials for BioTools and SequenceEditor 

Application tutorials teach you various applications on various Bruker Daltonics mass 
spectrometers. They allow you to practice applications using tutorial data that is 
supplied with the BioTools 3.2 package.  

 
1 Analysis of Crosslinked Peptides  
2 DeNovo Sequencing with BioTools  
3 Special Features for ESI Data   
4 Analysis of N-glycosylated Peptides  
5 Top-Down Sequencing 
6 Sequence Database Searches from MALDI Peptide Mass 

Fingerprints 
7 Automated Processing of Multiple PMF Samples: WARP II, Batch 

Mode  
8 Using BioTools and apexControl  
9 Analysis of Carbohydrates by MS/MS  
10 ETD and PTR with the HCTultra 
 
11 Basic Operation (SE)  
12 Localization of PTMs in Peptides by MS/MS (SE)  
13 Protein Digests (SE)  
14 Modify a Sequence (SE)  
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2.2 Getting Help 

1. Use the context sensitive help while you work: Press the F1 function key to 
access the software manual at exactly the relevant location for your problem. 

2. Access the various application tutorials through this document that guide you 
through a number of applications from the sample preparation to final data 
analysis. 

3. Get updated on the new features of BioTools 3.2 and BioTools 3.2 SR1-5 via 
menu Help → What´s new in BioTools 3.2. 

4. Call or email the software support:  
 

Bruker Daltonik GmbH   
Fahrenheitstr. 4   
D-28359 Bremen   
Germany   
 

 

Phone:  +49 (4 21) 22 05-345  
Fax:  +49 (4 21) 22 05-390  
E-Mail:  service.bdal.de@bruker.com 
Internet:  www.bruker.com 

 
 
2.3 Loading Processed Data 

First the spectra must be processed in the Bruker software flexAnalysis 2.4 (or higher) 
or DataAnalysis 3.4 (or higher). Additional peak picking can be done in BioTools. It is 
also possible to export the processed data directly from flexAnalysis or DataAnalysis 
into BioTools (see flexAnalysis and DataAnalysis tutorials).  

Note: When DataAnalysis 4.1 or higher was used to process the data set to be 
opened in BioTools the DataAnalysis 4.* software needs to be installed 
locally (license key is not necessary) for BioTools to read profile spectra 
for (xml/baf/yep) files. 

 

mailto:service.bdal.de@bruker.com
http://www.bruker.com/
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There are three ways to open processed data sets in menu File. 
 

Open… will open one selected data set of the type specified in the drop down box on 
the File Open dialog. 

And in Find… it is possible to search for types of data and to open one and more data. 

Multiple open 1r… is a good option to open all 1r data of one folder included or 
excluded its subfolders. 
 

When Open Spectrum… and Find… will be used a second time, the first time will be 
recollected. The path to the data or respectively the list of files that were found before 
are displayed again. 

In this example go to menu File/Find…. 
 

 
Figure 2-2  Load data: File menu 
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Figure 2-3  Load data: Find files with all possible file names 

  
Figure 2-4  Load data: File types for 1R 
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Different files are possible to load for different instruments: 

MALDI-TOF   
PMF 1R All, TOF  
MS/MS 1R PSD, LIFT  
combined .XML TOF + nLIFT combined peaklist 

 

esquire/HCT   
YEP/.BAF (Necessary to save results in DA before.)  
.XML  DataAnalysis-processed LC MS(n)-Compounds  
 (profile spectra will be shown with DataAnalysis 3.4 and 
 higher) 
.MGF (No raw data will be shown.)  
.BSC (BioTools 3.2 also supports this older file format.) 

 

micrOTOF, micrOTOF-Q, maXis  
YEP/.BAF (Necessary to save results in DataAnalysis before.)  
.XML  DataAnalysis -processed LC MS(n)-Compounds  
 (profile spectra will be shown with DataAnalysis 3.4 and 
 higher) 
.MGF (No raw data will be shown.)  
.BSC (BioTools 3.2 also supports this older file format.) 

 

FTMS  
.YEP/.BAF (Necessary to save results in DataAnalysis before.)  
.XML  DataAnalysis -processed LC MS(n)-Compounds  
 (profile spectra will be shown with DataAnalysis 3.4 and 
 higher.) 
.MGF (No raw data will be shown.)  
.BSC (BioTools 3.2 also supports this older file format.)  

 

 

 
Figure 2-5  Load data: File types for .XML 
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Browse to the shown path after "Look in". This path is the folder where BioTools was 
saved during program installation. Subfolders will be included for the search also 
because a tick is set for "Include subfolders". Click on the button  to start the 
search. All combined MALDI-TOF data sets of this folder are shown in the table 
underneath.  
 

From the list of found files select the entry as shown in Figure 2-6 and load it using the 
button .  

Load a second file for the navigating operations in BioTools. Go to menu/ Find Files, 
choose 1R and TOF as shown in Figure 2-4, select "BSA digest LysC" and open this or 
another MS-spectrum.  
 

 

  
Figure 2-6  Load data: Select one or more of the found files 
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2.4 Navigating in BioTools 

 
BioTools shows the processed data in four windows. Some windows can be hidden 

using the toolbar buttons Show/Hide Treeview  and Show/Hide Fragments . 
Each window can be changed in size. Move the mouse between two windows, the 
shape of the cursor will change to  press the left mouse button (LMB) and drag the 
boundary to the desired position. 

For more details on the toolbar buttons see chapter 3.3 Toolbar Reference and 
Shortcut List for BioTools.  

The Treeview window on the left displays the peak list and already all matches to 
protein sequences. Before using the database searches in BioTools all masses of the 
peaks are listed under "Unmatched" peaks. 

  
Figure 2-7 BioTools main display  
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The upper window is the Overview window that always displays the complete 
spectrum. The lower window is the Spectrum window and shows the selected range of 
the spectrum. At the bottom the Sequence or Fragments window is displayed (for 
details see the chapter 2.7 Overview on BioTools Window). 

All peaks of the mass list are signed with a vertical red line in the spectrum and the 
masses are annotated in black. 
 
 
2.4.1 Zooming and Moving of Spectrum Views 

In this chapter following descriptions will be used in a short form: 

LMB  Left mouse button 

RMB Right mouse button 

Drag  Move the mouse cursor to a starting point, click LMB or RMB, go to the 
desired point and release the mouse button. 

Note: After loading the spectrum, the Spectrum window shows the whole 
spectrum as in the Overview window. First, you have to zoom in the 
spectrum before you can zoom in the overview spectrum. 

There are several ways to move and zoom within the spectrum.  
 
 
2.4.2 Zoom Operation in the Spectrum Window 

Drag LMB from the upper left corner to the bottom right of a rectangle like it is shown 
in Figure 2-8. The Overview window will frame the detail of the spectrum with a black 
rectangle (Figure 2-9). 

Note: A single LMB click will reverse the last operation.  
A double LMB click within the Spectrum window will reset the display to 
the whole spectrum.  



Bruker 2 Quick Guide To BioTools 3.2 

BioTools 3.2  User Manual  Revision F Page 35 of 96 

 

 

  
Figure 2-8  Zooming in spectrum 

  
Figure 2-9  Zooming in spectrum, finished 
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The next figure and the table show all the possibilities to move and zoom in the 
spectrum. Navigate in the zoomed spectrum of Figure 2-9. Any operation in either the 
Overview window or the Spectrum window will set the context to the particular window.  
 

 
 
2.4.2.1 Use Cursor Keys to Move the Zoom Range 

Additional navigations are possible only by using following keyboard buttons, provided 
the context is on the Overview window resp. the Spectrum window (blue vertical 
bar on the left side, Figure 2-9 shows the context being on the Spectrum window):  

        move   in 90% box size step 

Shift        move   in 10% box size step 

CTRL        shrink/expand  in 90% box size step 

CTRL+ Shift       shrink/expand  in 10% box size step 
 
 

  
Figure 2-10  Operations for moving and zooming 
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2.4.2.2 Zoom onto Predicted MS/MS Fragments 

A LMB click on a fragment mass in the tab  will zoom on the fragment 
ion in the spectrum. 

For example load a combined PMF_LIFT spectrum. 
 

 
Select MSMS1 in the treeview to get the fragments of this MS/MS spectrum. If the 

Protein view is still displayed click on the button . The  tab will be 
displayed Figure 2-11).  

 

  
Figure 2-11  Zooming in on a fragment ion 
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Click on the y1 fragment in the table (see mouse cursor) and the spectrum zooms in 
on this fragment ion Figure 2-12.  
 

 

  
Figure 2-12  Zooming in on a fragment ion, finished 
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2.4.3 Edit Peak List 

Picked peaks of the peak list are displayed with a red vertical line in the spectrum. To 
edit peaks in BioTools there are two features.  

Manual peak picking: 
Peaks can be manually picked or deleted by pressing the Ctrl key and dragging the 
mouse with LMB pressed across a mass range (Figure 2-15). The maximum intensity 
peak will be affected in the drag range. Therefore in crowded parts of the spectrum, 
better zoom in on the peaks of interest first. Alternatively, the context menu entry "Edit 
Peaks" can be used to enter the manual peak editing mode until the RMB is clicked in 
the spectrum. 

With BioTools 3.2, the algorithm used for adding peaks in the manual peak editing can 
also be specified by using the menu entry "Configure Edit Peaks..". The Maximum 
algorithm is useful for arbitrary additions of peaks while the Sum PeakFinder should be 
used for micrOTOF-Q/maXis spectra (BioTools will attempt to use the same 
parameters as were previously used in DataAnalysis 3.4). 
 

 
Figure 2-13  Zooming in on a fragment ion, finished 
 



2 Quick Guide To BioTools 3.2 Bruker 

Page 40 of 96 BioTools 3.2  User Manual  Revision F 

Note: If there are any problems in editing very narrow peaks, just click the 
peak directly (Ctrl + LMB). The "minimal mass difference" between 
peaks could be edited in the "Peak Finder" dialog, see Figure 2-16. 

Peak picking is often useful after a database search to align fragments which were not 
labeled.  

 

 

Figure 2-14 Dialog Configure Edit Peaks 

 

  
Figure 2-15  Manual peak picking/deleting 
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Automatic peak picking of a region or the entire spectrum:  
Zoom in the region where the peaks should be picked again. Click on RMB and the 
context menu select "Peak Picking". The "Peak Finder" dialog (Figure 2-16) shows the 
parameters which can be changed for the automatic picking. Already picked peaks will 
be obtained. But it is possible to delete all peaks. The region for changing is the visible 
spectrum or the range which can be typed in. 
 

 
The PeakFinder settings are identical to those in the flexAnalysis or DataAnalysis 
programs, except that some options are not available here.  
 
 
 

  
Figure 2-16  Automatic Peak Picking 
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2.5 Working with Combined MS + nMS/MS Data 
Sets 

This chapter will give a short representation on how to work with BioTools especially 
for combined data sets. Detailed information about special topics you will find in the 
tutorials. 
 

2.5.1 Combine Peaklist 

An example is the data set of a PMF of BSA-digest and a number of LIFT-TOF/TOF 
MS/MS spectra from this sample. Load it as shown in Figure 2-6 or generate your own 
combined data set as described below. 

Load exactly 1 MS spectrum and n MS/MS spectra as shown in Figure 2-17.  

  
Figure 2-17  Load 1 MS and n MS/MS files into BioTools to manually generate a 

combined PMF+nLIFT data set 
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They can be analyzed now as individual data sets that are not related. In order to deal 
with them as a single combined data set that contains 1 PMF and n LIFT spectra, they 
need to be merged.  

Combine the data: menu: File/ Combine TOF  + multiple LIFT spectra (Figure 2-18). 
 

A dialog opens that lists all files currently open in BioTools (PMF_LIFT spectra need to 
be closed before you enter this dialog!).  

 

 
Figure 2-18  Combine multiple LIFT spectra 
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Remove open files of other samples currently open in BioTools by selecting them in 
the table and clicking on .  the "Output file" name if you want to save a 
second combined data set of the data from same sample position. Combine the listed 
files into that data set with  
 

Note: Single MS and multiple MS/MS spectra can be combined. Even later, 
processed data can be added for improved results. 

 
A new window PMF2_LIFT will show now the combined data set. Peaks of the MS 
spectrum and the done MS/MS spectrum of a peptide peak are listed in the treeview 
under "Unmatched" peaks. 

  
Figure 2-19  Select spectra 
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Figure 2-20  Combined data set: PMF_LIFT 
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2.5.2 MS and MS/MS View 

With the toolbar buttons  and  you can switch between the display of the PMF 
type information/Protein Sequence Viewer (MS) and the Fragment Ion Spectrum of a 
selected treeview entry (MS/MS). 

If the MS View was selected, a Mascot MS search can be done by clicking on  and 
after result import the whole protein sequence is displayed. If the MS/MS View was 
selected, a Mascot MS/MS search can be done by clicking on . After result import 
MS/MS–fragment ions are assigned for each individual selected parent. For many 
samples and automated analysis use the batch mode that can be accessed through 
the  button (see also Tutorial - Automated Processing of Multiple PMF 
Samples: WARP II, Batch Mode). 
 
 
2.5.3 Database Search in MS View (PMF Data) 

In the MS view  click the  button to open the search dialog shown in Figure 2-22. 

For details of Mascot query parameters use the F1-key context sensitive help or see 
the www.matrixscience.com online help. 

 

  
Figure 2-21  Toolbar detail 

http://www.matrixscience.com/
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Figure 2-22  PMF search parameters 
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Adjust the search parameters and press . After some time the results of the query 
will be displayed in Query Results window, see Figure 2-23.  

There will be an overview graphic of the significance, a list of the hits with links to the 
protein for more information and the search parameters at the end. 
 

 

Use the button  to transfer the query results into BioTools. Number "1" 
means: get the top hit only. "1-3, 10" means: get hits 1-3 and 10.  

  
Figure 2-23  Results of MS search 
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Figure 2-24  Database results of MS search in BioTools 
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The peptide masses are listed in the treeview on the left side of the BioTools window. 
If the protein sequence node is selected in the treeview, the PMF is properly annotated 
with the sequence positions and the entire protein sequence is shown at the bottom. 
Matching peptides (grey bars) are displayed and even the available matching MS/MS 
information (though not used for this search) is available from this display as series of 
red bricks (upper row: b-ions, lower row: y-ions). Peptides can be selected either in the 
sequence or in the treeview. 

Alternatively to the  tab for MS-spectra (Figure 2-24) also the differences 
between the calculated and the measured matched masses are displayed as a graph 
under the  tab.  
 

 

  
Figure 2-25  Error plot of the PMF: errors of the identified peptides vs. their 

molecular weight 
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2.5.4 Database Search in MS/MS View 

Click the  button in the toolbar and  to do the database search for MS/MS ions.  
 

 
Figure 2-26  MS/MS Ions Search parameters 
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Click  and after some time the results of the Mascot query will be displayed. 

The result of this search is more specific as all MS/MS scores are accumulated 

(Mascot Score 999 instead of 174). Use the button  to transfer the query 
results into BioTools.  
 

After clicking in the treeview on a peptide entry the annotated fragment ion spectrum is 
displayed (Figure 2-28). The ion series have different colors in the spectrum for a 
better clarity. Click onto a theoretical mass in the table to zoom in on that peak in the 
spectrum. This targeted verification of the presence of small undetected peaks is a 
powerful validation tool to confirm sequence assignments, see also Edit Peak List.  

More detailed descriptions and further analytical workflows are described in the 
Tutorials and in the Online Help. 

 

 

  
Figure 2-27  Results of MS/MS search 
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Figure 2-28  Database results of MS/MS search in BioTools 



2 Quick Guide To BioTools 3.2 Bruker 

Page 54 of 96 BioTools 3.2  User Manual  Revision F 

2.6 Useful Hints 

 
2.6.1 How to Use this Manual and the Help Functionality 

within BioTools 

The Operator Manuals are meant to be online help documents, which can be accessed 
using the F1 key at any point of entry of the program. In addition, they can be read like 
a book, which is not recommended whatsoever. 

The two tutorial blocks with focus on either the SequenceEditor or BioTools contain 
procedure descriptions for specific analytical problems. Work your way through those 
applications, which you want to learn about and use the F1 access to online help only 
where needed.  
 
 
2.6.2 Send Mascot Search Result Pages via Email to 

Somebody Who Does Not Have BioTools 

• Perform the search under BioTools. Next to the data file opened (e g 1r) 
BioTools generates a copy of the HTML results page named *.html) 

• On the same computer open this file in Internet Explorer (the first page opens 
up and connects to the Mascot server to display the full result page) 

• This file can be sent to and opened by anybody. 
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2.7 Overview on BioTools Window 

This chapter will give an explanation of all BioTools window areas and how to handle 
data and sequences.   
 

 

The active window is marked with a blue bar on the left.  

The windows typically provide context menus that are accessed through a click with 
the right mouse button, while the cursor points to the window.  

 

Figure 2-29 BioTools window 



2 Quick Guide To BioTools 3.2 Bruker 

Page 56 of 96 BioTools 3.2  User Manual  Revision F 

The working area within BioTools is separated into four windows and three bars:  

Treeview window  

Overview window  

Spectrum window  

Fragments window 

Menu Bar  

Toolbar  

Status Bar  

 
 
 
2.7.1 Menu Bar 

The menu bar can be moved with the mouse. Click with the left mouse button on the 
background of the menu bar and move the menu bar with the mouse button pressed to 
the desired position.  
 
 
2.7.2 Toolbar 

The toolbar can be dragged using the mouse. Click with the left mouse button on the 
background of the toolbar and move the toolbar with the mouse button pressed to the 
desired position. For details on the toolbar buttons see the chapter 3.3 Toolbar 
Reference and Shortcut List for BioTools. 

The toolbar can be updated to show all available buttons using menu 
Tools/Customize..: On the dialog select ‘Menu Bar’ and ‘Default’ toolbars and press the 
Reset button for each of those, this will add a TDS button to the Mascot search 
options: 

  
Figure 2-30 Toolbar 
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2.7.3 Status Bar 

By activating this option in the View menu the lower status bar is shown (standard) or 
hidden.  

In the left corner is given a short help text corresponding to the cursor position and 
actions.   

The next boxes show the activated caps lock and the numeric function of the numeric 
block, followed be the currently logged user.  

In the right corner is given the x-position and y-position (or x-distance) of the cursor (if 
not deactivated).  
 

 
 

  
Figure 2-31 Status bar 
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2.7.4 Spectrum Window 

Displays one spectrum with sequence annotations and allows editing of the peak list. 
The Spectrum window can display either MS spectra (e.g. MALDI-PMF) or MS/MS 

spectra, depending on the selection of the display mode  in the tool bar and 
the data type loaded. (F4) allows toggling between MS and MS/MS display mode. 

• zoom in: drag cursor with left mouse button pressed (LMB) across the zoom 
area 

• zoom out to last view: click LMB in the Spectrum window (4 repeats maximum) 

• undo and redo zooming buttons   allow to toggle between views  

• zoom out to full spectrum: double-click LMB in the Spectrum window 

• add or delete peaks by CTRL-drag LMB across peak.  

• move axis: drag LMB across scale bar of the axis of interest 

• expand/shrink axis drag RMB (right mouse button) the scale bar of the axis of 
interest 

• format axis and spectrum labels: RMB click on axis opens context menu that 
allows to  

• Hide axis scale bar 

• Format axis and peak labeling 

• change axis background color 

• Short keys for further x-axis operations:   
F9  zoom in x-axis.  
F10  zoomed out x-axis. 
F11  zoom box moves right. 
F12  zoom box moves left. 

• The zoom view can be controlled using  
   2.4.2 Zoom Operation in the Spectrum Window 
      2.4.2.1 Use Cursor Keys to Move the Zoom Range 
      2.4.2.2 Zoom onto Predicted MS/MS Fragments 
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2.7.5 Treeview Window 

All protein sequence candidates with all matching peptides are listed in the treeview, a 
single protein or peptide can be selected for the spectrum display. The treeview 
provides a sorted, optionally filtered, view onto a data set in a tabulated form. The data 
set can be a single PMF with several sequence candidates associated, a single 
MS/MS spectrum or an entire LC-MS/MS data set.  

Important Note:  The Perform Digest and Mass Search function buttons  
are only accessible if the "Digest Matches" node underneath 
the protein name is selected 

 
• Send sequences to SequenceEditor 

o  by double-click on the sequence  

o Click on Digest matches (see Fig.)  

• Move through the treeview with arrow keys  and . 

• Unfold/fold sublevels with arrow keys  and . 

• Move through the treeview on one hierarchy levels using TAB and SHIFT TAB. 

• Select a peptide sequence in the treeview  
o MS tab: to highlight it (green) in the Protein View and annotate its MS 

signal is in the Spectrum window. 
o MS/MS tab: to display the sequence with matching MS/MS fragments in 

the Fragments window and the annotations in the Spectrum window 

• To hide a peak, uncheck it in the treeview. It will remove it from all calculations 
(e.g., sequence coverage) and from spectrum annotation, but it will not delete 

 
Figure 2-32 Treeview appearance  
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it. This state will be saved with other data set processing, which is useful as it 
allows keeping rejected assignments for later reevaluation.  

 
 
2.7.6 Overview Window 

The Overview window always displays the entire spectrum. The spectrum view may 
show only a fraction of it after zooming in. A zoom box framing that detailed view is 
displayed in the spectrum overview. This zoom box can be arranged with the mouse by 
left-clicking on the borders. It can be moved by left-clicking in the rectangle and 
drawing.  

• The zoom view can be controlled using  
   2.4.2 Zoom Operation in the Spectrum Window 
      2.4.2.1 Use Cursor Keys to Move the Zoom Range 
      2.4.2.2 Zoom onto Predicted MS/MS Fragments 

 
The arrangement of the rectangle can also be set with the arrow keys and/or Ctrl 
and/or Shift key.  
 

Arrow - Shift Ctrl Ctrl + Shift 

 moving with a 
little overlap  

moving in short 
steps  

scaling the 
rectangle roughly 

scaling the rectangle 
in short steps  

right   right  right  increase width,  
center fix 

increase width,  
center fix 

left   left  left  decrease width,  
center fix  

decrease width,  
center fix  

up   up  up  increase height,  
baseline fix 

increase height,  
baseline fix 

down   down  down  decrease height,  
baseline fix 

decrease height,  
baseline fix 
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2.7.7 Fragments Window 

The sequence view has different appearance and functionality depending on the 
displayed MS or MS/MS data type (see chapter 2.7.4 Spectrum Window). 

MS View : the Protein View and the Match Errors tabs are active.  

MS/MS View : the Match Errors, the MS/MS Fragments and the MS/MS 
Analysis is shown. In the MS/MS Analysis tab either the fingerprint info or the DeNovo 
Sequencing info is shown.  

F4 allows toggling between MS and MS/MS display mode. 
 
 
2.7.7.1 Protein View  

A protein sequence selected in the treeview on the left is displayed and the detected 
peaks are annotated in the Spectrum window, the treeview and the Sequence window 
corresponding to this sequence.  
 

 

 
Figure 2-33 Protein View appearance  
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Interesting information available directly from the display:  
Protein: name according to information imported from Mascot or Sequence Editor 

Intensity coverage (%): Fraction of peak intensities that are assigned to the protein 
divided by the total intensities of all MS peaks in the data set. 100 % means all 
peaks in the spectrum are assigned to the protein. Very relevant diagnostic value 
that estimates to what degree a data set is accounted to identified proteins/peptide. 

Sequence coverage MS: Fraction of amino acid residues that are assigned to the 
protein sequence by MS data vs. all residues in the protein sequence. Diagnostic 
parameter that expresses the degree of knowledge about a protein available from 
MS information in a data set (e.g. from MALDI-PMFs). 

Sequence coverage MS/MS: Same as above, except only those peptides are 
accounted for that were IDed by MS/MS. Diagnostic parameter that expresses the 
degree of knowledge about a protein available from MS/MS information in a data 
set (e.g. from LC-MS/MS). 

pI: isoelectric point calculated from entire protein sequence. 

MW [kDa]: Molecular weight calculated from entire protein sequence. 

Peak threshold: only peaks above this threshold are annotated. Threshold can be 
defined under Analysis > Set Threshold.  

 

Visualization and interaction inside the Protein View tab: 

• Individual peptides can be selected in the sequence view or in the treeview 
(background color changes to green).  

• If MS/MS spectrum is available for the selected peptide – indicated by the red 
bricks inside the grey peptide bar – F4 key allows direct access to the sequence 
annotated MS/MS spectrum of a selected peptide (green background color). 

• Red bricks indicate matching N-terminal fragment ions (upper row) and C-
terminal fragment ions (lower row); can be defined via the Protein View context 
menu.  

• N-Glycane consensus motif (NXS/NXT) is marked in yellow  

• The appearance of the sequence view can be controlled through the Protein 
View context menu.  
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2.7.7.2 Match Errors 

  

Displays the mass errors (Da or ppm) of the peptide peaks matching the protein 
sequence selected in the treeview. A selected peptide is highlighted in green as shown 
in the figure. 

The RMS Error across all matching peptides is displayed on top in the selected unit. 

Powerful diagnostic tool to estimate calibration drift of data sets, confidence range for 
improved database search settings etc. 

The graphic can be copied as an image via the Match Errors context menu.  
 
 
2.7.7.3 MS/MS Fragments 

If an identified peptide sequence is selected in the treeview and the MS/MS display 
mode is active ( ), the annotated spectrum is displayed. Under the MS/MS 
Fragments tab, interaction with peaklist and spectrum are easily possible. 

Figure 2-34 Match Errors 
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Most importantly, the matches between theoretically calculated fragment ion masses 
(as shown) and the peaks in the MS/MS spectrum of the IDed peptide are highlighted 
in red, theoretical fragments that do not match to an experimental peak are shown in 
black.  
Note:  The fragment ion series to be displayed and calculated can be selected 

or defined from the toolbar with the button  (see chapter 2.7.2 
Toolbar)! This is mandatory for proper display when switching between 
different fragmentation modes such as ETD/CID or ESI/MALDI. 

This provides a direct overview to what extent a peptide sequence is accounted for by 
the experimental data and an entry point for further evaluation.  

Typical tasks: 
Peaklist OK? Check if a fragment ion actually does not match or was, perhaps, not 
properly detected during peaklist generation: 

• click on the black coded mismatch mass in the fragment table – the display will 
zoom onto that mass  

• if a peak is actually present in the raw data add that peak to the list (keep Ctrl 
and LMB pressed and drag the cursor across the peak). Use the same 
procedure to remove peaks from the list. 

Sequence + PTMs correct? Check which of 2 or more sequence candidates –or e.g. 
phosphorylation sites – better account for the experimental data: 

• define the sequence or PTM variants in SequenceEditor and send them all to 
BioTools with the spectrum in question selected 

• In the treeview context menu, use the Match all entries function to sort al 
variants according to their quality of match  

• for each structure candidate check for matching and mismatching fragment ions 
to ensure sloppy peak picking does not account for preference of one sequence 
candidate over the other as described under Peaklist OK?. 

 

  
Figure 2-35 Fragments window with parameters and annotation information 
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Contents of the Fragments window:  

 Sends the displayed sequence to the SequenceEditor. The 
sequence, modifications and its title (in brackets) is shown in 
the field to the right. If there is a sequence available but not 
shown in the display: press the sequence button, type in/paste 
the sequence into SequenceEditor and send it back to 
BioTools for display at this point.  

Symbol If there is an irregular letter contained in the sequence (X, Z, 
B, etc), a message pops up and a symbol is placed in the title.  

MH  (mono)  Monoisotopic mass of the single protonated sequence is 
shown. 

MH  (avg)  Average mass of the single protonated sequence is shown. 
Masses  Select the type of masses (Mono./Avg.) for 
calculation of the fragments below. 

Calculate  Select the display format of the table below:  
None  shows sequence only  
Masses calculates fragment ion masses (standard!) 
Errors [Da]  calculates exp. fragment mass errors [Da]  
Errors [ppm]  calculates exp. fragment mass errors [ppm]  

MS/MS Tol.  Enter the tolerance (Da or ppm) for matching theoretical with 
experimental fragment ions. The drop-down box to the right 
allows the unit to be specified. Matches are indicated in red in 
the table below, mismatches in black. 

Threshold Define a threshold peak intensity according to the y-scale for 
the display of annotations. 

 Zoom the displayed mass range to the one possibly displaying 
the next highest or lower charge state to check its presence – 
relevant for ESI-MS/MS(n) spectra. E.g., click on fragment 
102.05 in the table, then Zoom to m/z for 2+, to zoom in on 56 
Da. 

Zoom +/- Sets the Zoom range for the zoom to mass functionality in the 
spectrum (clicking on a fragment mass in the fragment table 
or error point in the error plot.) 

Peaks  Number of picked peaks in the MS/MS peaklist  
Above Threshold Number of peaks above defined threshold  
Assigned  Number of peaks matching the theoretical fragments 

calculated from sequence according to ion series selection 
under Toolbar button . 
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Not Assigned  Sum of Assigned and Not Assigned peaks equals the 
number of all peaks Above Threshold.  

To view an already existing sequence via the Treeview window, select the desired 
sequence by clicking on it with the left mouse button.  
 
 
2.7.7.4 MS/MS Analysis 

This tab provides DeNovo Sequencing Tools for Bottom-Up and Top-Down work to 
extract sequence information from MS/MS data and to use it for database searching.  
Depending on data quality and type, these may constitute complete sequence 
suggestions or only "seed" sequences or sequence tags, which require further 
interactive work (via MS/MS Analysis context menu).  

 
Procedure:  
1. Select the Analysis Mode using a radio button on the top left to enable only those 
features that are useful for either Bottom-Up or Top-Down work.  

Bottom-Up: protein digests, typically analyzed with CID type MS/MS methods on all 
instruments, ETD analysis of digests on the trap included. 

Top-Down: Intact protein work using MALDI-TDS (ISD), ETD or ECD of peptides and 
proteins (see application tutorial on top-down sequencing in chapter 2.1.2 Application 
Tutorials for BioTools and SequenceEditor). 
 

 
2. Enter proper MS/MS tolerance, threshold intensity and – if automatically available– 
the monoisotopic parent MH+. 

  
Figure 2-36 Fragments window with DeNovo sequencing parameters for 

Bottom-Up analysis 
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3. Using MS/MS data providing immonium ions (i-type, e.g. from MALDI-TOF/TOF) 

click  to get information about existing amino acid residues, the 
absent residues obtained should only be left in the field if the information appears 
reliable! I and Q should be generally included as absent to avoid redundant sequence 
assignments. Absent masses are defined in a blank-separated list. 

Edit Fragments Allows modifying the fragment ion properties relevant for Check 
Low Masses. (Use only for development purposes) 

Find Neutral Losses Will screen for defined Neutral Loss groups such as 
phosphorylation, Met-Ox etc.  

Edit Neutral Losses Allows the list of Neutral Losses to be extended.  
 

Contents of the sequence view tab MS/MS Analysis:  
Peaks  Number of peaks in the peaklist  
Above Threshold Number of peaks above the entered threshold intensity 
MS/MS Tol.  Enter the MS/MS mass tolerance (in m/z), for calculating a match  
Threshold Excludes peaks below the threshold intensity for all calculations 

and display  
MH (exp)  The monoisotopic mass of peptide MH+ derived from the 

spectrum  
Absent  Excludes listed amino acid residue types (space-separated) from 

any calculation. Typically at least I and Q are defined, I (Ile) only 
if MS/MS Tol. set to < 0.05 

Uncertain  Shows the amino acid types suggested being uncertain by the 
Low Masses button operation 

Present  Shows the amino acid residues types suggested to be present by 
the Low Masses button operation 

 
 Annotates pairs of b and y ions in the data file, which result from 

the dissociation of the same peptide bond; the results are shown 
in the Spectrum window. This may assist in largely manual 
DeNovo sequencing studies but are typically not needed if 
RapiDeNovo is used.  

Important: The mass error must be set 2x as high as the actual mass error for a single 
fragment ion. 
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The following options are based on matching peak distances to particular theoretical 
masses.  

 Searches for all defined neutral losses in the currently open 
MSMS spectrum. 

 Opens an editor for the (user-defined) neutral losses that are 
stored in the method folder. 

 

 Opens a dialog that can be used to search for all MSMS spectra 
containing neutral losses that were defined using the button "Edit 
Neutral Losses..". The list of found MSMS spectra can be copied 
to the clipboard. 

 Opens a dialog that can be used to search for all MSMS spectra 
that contain an MSMS peak that is surrounded by a user-defined 
pattern, this can be used e g to find all MSMS spectra that contain 
the pattern -32/+34 Da that is characteristic of disulfide-linked 
peptides. 

 Creates sequence tags based on matched b-y ions; the results are 
shown in the spectrum.  

 Starts the sequence tag search on PeptideSearch at EMBL (this is 
deprecated).  
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Figure 2-37 Sequence Tag Search dialog  



2 Quick Guide To BioTools 3.2 Bruker 

Page 70 of 96 BioTools 3.2  User Manual  Revision F 

 Opens the Find Tags dialog for sequencing workflows, Top-
Down or Bottom-up. respectively.  

 
Optional and Fixed modifications can be defined depending on suspected 
modifications and the protein chemistry employed. 

 
Figure 2-38 Find Tags dialog 
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The number of sequence tags created and annotated controls calculation time and 
display clarity and their minimum and maximum number of residues can be limited. 
MALDI-TDS (reISD) data may require a minimum setting of, e.g., 10 residues for c-
ions, whereas typical Bottom-Up data require 2-5. 

The absent amino acid residues were previously defined under the MS/MS Analysis 
tab. 

The MS/MS tolerance is defined another time here, allowing for stricter accuracy 
requirements for sequencing (tag generation) than for annotation (as defined under the 
MS/MS Analysis tab.  
 
The check boxes allow a better controlling particularly of Top-Down sequencing:  
Non redundant Tags ..  Excludes shorter tags that are entirely covered by 

longer ones 
DeNovo mode  When this option is selected only the 2 highest intensity 
(only use 2 best peaks)  or closest-matching peaks are used to extend a tag; 

other potential matches are ignored. This option is 
useful if the most intense peaks in the spectrum 
correspond to the fragments of one series with MALDI 
ISD spectra. 

Tag must include peak mass Only returns tags that match the peak specified in the 
drop-down box. Powerful tool to direct the automated 
calculation to obvious peaks. 

Calculate Tags from .. to: Allows confining tag calculation to a mass range or to 
extend previously obtained tags contained in the list 
box. 

Exclude masses…  Excludes any peaks from calculations that are matched 
by tags already and that are contained in the 
Saved/Excluded list of tags in the MS/MS Analysis tab 
(e.g. to sequence low intensity y-ion tags after 
completing high intensity c-ion tags in MALDI-TDS). 

Ignore all peaks…  Excludes any peaks that are matched by the currently 
selected sequence in the treeview (e.g. to sequence 
tags belonging to another protein present in the 
sample). 

Include Proline gap  Use for c-ion series based sequencing particularly in 
MALDI-TDS. This option accounts for a property of c-
ion series obtained by ISD, ETD and ECD: c-ions 
(dominant in MALDI-TDS) are not produced N-terminal 
to Pro as this would involve ring cleavage, therefore X-
Pro mass differences are included into the calculation 
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See also the application tutorial on the analysis of ISD data (see chapter 
2.1.2 Application Tutorials for BioTools and SequenceEditor).  

 

 Opens the filters dialog to set the valence of the ions and the 
minimum and maximum values of the search. The number of hits 
depends to the previously selected value and order above the list 
window.  

 
 Top-Down only with a reference sequence loaded to the 

fragment ion spectrum: selects those tags in the upper list box 
matching the selected protein sequence in the BioTools 
treeview. In this way Signal Peptides can be discovered. 

 Opens the Mascot Sequence Query dialog containing the 
formatted data from the selected tags in the lower list box (for 
Top-Down Analysis as MassOfTag seq(*-TAG). For Bottom-Up 
Searches this should be reformatted as ParentMass 
tag(startmass, TAG, endmass). See Mascot Help for further 
details on the formatting of this query. 

 Requires a RapiDeNovo license: for advanced DeNovo 
sequencing. For further information see the RapiDeNovo 
Tutorial.  

 

  
Figure 2-39 Filters dialog with settings for PSD. Ion trap settings should be 1.0 

for "If mass is absent:" p(a), p(a-17) and p(b-17) 
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 Top Down only: this starts the Mascot TDS search procedure, 
at first a dialog for selection of virtual parent masses for the 
MSMS peak list is shown. 

 

The mass range that was set previously by zooming in the spectrum to a mass range 
containing fragment ions is displayed as well as the intensity threshold set. This dialog 
calculates the masses of peptides based on an assumed ion type for the MSMS peak, 
if a peak of MH+ 1000.0 is assumed to be a c-ion the corresponding peptide from 
unspecific cleavage would be 1015. For other ion types a different mass offset is 
applied. The Virtual mass calculation recognizes 5 different types of ions: a, c, y, z+1, 
z+2. The subset of these contained in the currently selected ion series for annotation is 
used for virtual parent calculation and displayed on the dialog box above the list. The 
button "Change ion type in selected rows to:" can be used to change the ion type that 
is derived from c/a or z+2/y pairs in MALDI-ISD spectra. 

Figure 2-40 TDS Mascot Search – Select Virtual Parent Masses dialog 
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All checkmarked peaks in the list will be used for virtual parent calculation. Clicking on 
"Next.." will open the Mascot MSMS search dialog with the virtual spectra already 
entered. 
Please refer to the tutorial on top-down sequencing for details on the TDS search 
feature (see chapter 2.1.2 Application Tutorials for BioTools and SequenceEditor). 

 
 This will search for a mass offset from a defined list of fragment 

mass offsets between start mass of the experimentally found 
tag and the one calculated from the protein sequences 
contained in the BioTools treeview). (Here, a c-ion match was 
found with the sequence of Serum Albumin precursor within 
0.04 Da. In the native sequence (BSA) the signal peptide was 
correctly identified based on the start masses of the tags)!).  

 

 
Figure 2-41 Find Tag Offsets dialog 
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 Displays the current theoretical offsets as defined in the 
default modification file for the building blocks: Amino Acids. 
The list can be edited using the Sequence Editor (menu Edit 
→ Modification-Types) by selecting a different .mod file. 

 
The following 2 buttons permit using the calculated sequence tags (preferably only 
one!) for error tolerant protein identification, seeding the more detailed characterization 
at a later stage using the AnalyzeTags.. function. 

 Copies all selected sequence tags without any MS info (from both list 
boxes) into the clipboard formatted backwards and forwards for 
search with MS-BLAST (EMBL/Harvard). 

 Opens the Harvard web page for the MS-BLAST homology search 
via internet. Please paste (Ctrl-V) the previously copied sequences 
into the entry field on the website and submit the query.  

 
Figure 2-42 Show Fragments Offsets dialog 
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The sequence tags in the lower Saved/Excluded list are secured while not interfering 
with further interactive work using Find Tags. Highlighted tags in that list are used for 
Mascot Sequence Queries and the Analyze Tags function. 

 Moves selected entries from the upper to the lower list 
control. 

 Moves selected entries from the lower to the upper list 
control. 

 

2.7.7.5 Sequence View 

If an identified peptide sequence is selected in the treeview and the MS/MS display 
mode is active the Sequence View tab shows an overview of the fragment coverage of 
the peptide sequence. 

 
Figure 2-43 Sequence View tab of Fragments window 

The display is calculated in the same way as for the Protein View (based on the 
selected ion series for annotation and the matching tolerance). Its main purpose is to 
provide a quick overview of the fragment and intensity coverages of Top Down data 
sets such as those generated by MALDI ISD. 

Red bricks indicate matching N-terminal fragment ions (upper row) and C-terminal 
fragment ions (lower row). 

Intensity coverage (%): Fraction of peak intensities that are assigned to the MSMS 
fragments divided by the total intensities of all MSMS peaks in the data set. Relevant 
diagnostic value that estimates to what degree a spectrum is explained by a peptide 
sequence. 

Sequence coverage MS(%): Fraction of amino acid residues that were IDed by 
MS/MS. Diagnostic parameter that expresses the degree of knowledge about a protein 
available from MS/MS information in a data set. 
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There are 3 different ways of calculating the sequence coverage that can be selected 
using the Sequence View – Context Menu or Protein View – Context Menu. 

Update (Match all Entries): This button updates the matches between MSMS peaks 
and fragments of the currently displayed protein sequence. The button can be used to 
ensure that the displayed fragment matches reflect the current state of the analysis. 

 

mk:@MSITStore:C:\PROGRAM%20FILES%20(X86)\BRUKER%20DALTONIK\BIOTOOLS\MSTOOL.CHM::/Useful_Hints_rtf/Context_Menu_Sequence_View.htm
mk:@MSITStore:C:\PROGRAM%20FILES%20(X86)\BRUKER%20DALTONIK\BIOTOOLS\MSTOOL.CHM::/Useful_Hints_rtf/Context_Menu_Protein_View.htm
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3 APPENDIX  

3.1 Amino Acid Residues  

3.1.1 Single Letter Code 

Most of the analysis programs use the single letter code - learn it by heart from: 
http://alpha2.bmc.uu.se/~kenth/bioinfo/singleletter.html  

 

Name Three Letter Code Single Letter Code Mnemonic 
Alanine Ala A (Alanine) 
Cysteine Cys C (Cysteine) 
Aspartic Acid Asp D (aciD) 
Glutamic Acid Glu E (E comes after D) 
Phenylalanine Phe F (Ph=F) 
Glycine Gly G (Glycine) 
Histidine His H (Histidine) 

Isoleucine Ile I (Isoleucine) 
Lysine Lys K (L follows K) 
Leucine Leu L (Leucine) 
Methionine Met M (Methionine) 
Asparagine Asn N (AsparagiNe) 
Proline Pro P (Proline)   
Glutamine Gln Q (Qlutamine) 
Arginine Arg R (aRginine) 
Serine Ser S (Serine) 
Threonine Thr T (Threonine) 
Valine Val V (Valine) 
Tryptophan Trp W (Double ring - W) 
Tyrosine Tyr Y (tYrosine) 

 

 

 

http://alpha2.bmc.uu.se/~kenth/bioinfo/singleletter.html
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Single Letter Code Three Letter Code Mnemonic 
A Ala Alanine 
C Cys Cysteine 
D Asp asparDic acid 
E Glu gluEtamic acid 
F Phe Fenylalanine 
G Gly Glycine 
H His Histidine 
I Ile Isoleucine 
K Lys before L 
L Leu Leucine 
M Met Methionine 
N Asn AsparagiNe 
P Pro Proline 
Q Gln Q-tamine 
R Arg aRginine 
S Ser Serine 
T Thr Threonine 
V Val Valine 
W Trp tWo rings 
Y Tyr tYrosine 
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3.1.2 Genetic Code  

 

1. 2. 3. 
 T C A G  

T 

TTT Phe [F] 
TTC Phe [F] 
TTA Leu [L] 
TTG Leu [L] 

TCT Ser [S] 
TCC Ser [S] 
TCA Ser [S] 
TCG Ser [S] 

TAT Tyr [Y] 
TAC Tyr [Y] 
TAA Ter
 [end] 
TAG Ter
 [end] 

TGT Cys [C] 
TGC Cys [C] 
TGA Ter
 [end] 
TGG Trp [W] 

T 
C 
A 
G 

C 

CTT Leu [L] 
CTC Leu [L] 
CTA Leu [L] 
CTG Leu [L] 

CCT Pro
 [P] 
CCC Pro
 [P] 
CCA Pro
 [P] 
CCG Pro
 [P] 

CAT His [H] 
CAC His [H] 
CAA Gln [Q] 
CAG Gln [Q] 

CGT Arg [R] 
CGC Arg [R] 
CGA Arg [R] 
CGG Arg [R] 

T 
C 
A 
G 

A 

ATT Ile [I] 
ATC Ile [I] 
ATA Ile [I] 
ATG Met [M] 

ACT Thr [T] 
ACC Thr [T] 
ACA Thr [T] 
ACG Thr [T] 

AAT Asn [N] 
AAC Asn [N] 
AAA Lys [K] 
AAG Lys [K] 

AGT Ser [S] 
AGC Ser [S] 
AGA Arg [R] 
AGG Arg [R] 

T 
C 
A 
G 

G 

GTT Val [V] 
GTC Val [V] 
GTA Val [V] 
GTG Val [V] 

GCT Ala [A] 
GCC Ala [A] 
GCA Ala [A] 
GCG Ala [A] 

GAT Asp [D] 
GAC Asp [D] 
GAA Glu [E] 
GAG Glu [E] 

GGT Gly [G] 
GGC Gly [G] 
GGA Gly [G] 
GGG Gly [G] 

T 
C 
A 
G 
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3.1.3 Formulas and Molecular Weights  

Amino acid residue masses (mono-isotopic and average) together with 3- and 1-letter 
code and elemental composition: 

 

Name Symbol C H N O S Monoisotopic  
Mass 

Averaged 
Mass 

Alanine Ala (A) 3 5 1 1 0 71.03712 71.079 

Cysteine Cys (C) 3 5 1 1 1 103.00919 103.145 

Aspartic acid Asp (D) 4 5 1 3 0 115.02695 115.089 

Glutamic acid Glu (E) 5 7 1 3 0 129.0426 129.116 

Phenylanaline Phe (F) 9 9 1 1 0 147.06842 147.177 

Glycine Gly (G) 2 3 1 1 0 57.02146 57.052 

Histidine His (H) 6 7 3 1 0 137.05891 137.141 

Isoleucine Ile (I) 6 11 1 1 0 113.08407 113.159 

Lysine Lys (K) 6 12 2 1 0 128.09497 128.174 

Leucine Leu (L) 6 11 1 1 0 113.08407 113.159 

Methionine Met (M) 5 9 1 1 1 131.04049 131.199 

Asparagine Asn (N) 4 6 2 2 0 114.04293 114.104 

Proline Pro (P) 5 7 1 1 0 97.05277 97.117 

Glutamine Gln (Q) 5 8 2 2 0 128.05858 128.131 

Arginine Arg (R) 6 12 4 1 0 156.10112 156.188 

Serine Ser (S) 3 5 1 2 0 87.03203 87.078 

Threonine Thr (T) 4 7 1 2 0 101.04768 101.105 

Valine Val (V) 5 9 1 1 0 99.06842 99.133 

Tryptophan Trp (W) 11 10 2 1 0 186.07932 186.213 

Tyrosine Tyr (Y) 9 9 1 2 0 163.06333 163.176 
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3.1.4 Chemical Structures  

  
Figure 3-1 Neutral hydrophobic amino acids 

  
Figure 3-2 Basic and acidic amino acids 



3 Appendix Bruker 

Page 84 of 96 BioTools 3.2  User Manual  Revision F 

 

 
 
3.2 Peptide Fragmentation 

The types of fragment ions observed in an MS/MS spectrum depend on many factors 
including primary sequence, the amount of internal energy, how the energy was 
introduced, charge state, etc. The nomenclature used for fragment ions is the Biemann 
nomenclature (R. S. Johnson, S. A. Martin & K. Biemann (1988), Int. J. Mass Spec. Ion 
Procs. 86, 137-154).  

Fragments will only be detected if they carry at least one charge. If this charge is 
retained on the N terminal fragment, the ion is classed as either a, b or c. If the charge 
is retained on the C terminal, the ion type is either x, y or z. An index indicates the 
number of residues in the fragment. In addition to the proton(s) carrying the charge, c 
ions and y ions abstract an additional proton from the precursor peptide. Note that 
these structures include a single charge carrying proton. In electrospray ionization, 
tryptic peptides generally carry two or more charges, so those fragment ions may carry 
more than one proton. 

  
Figure 3-3 Neutral polar amino acids 
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Typical fragment ions observed are:  

• Low energy CID:  b and y  

• PSD:  a, b, y and i, including neutral losses of NH3 from a and b 

• ISD:  c and y  

• ECD-FTICR:  c and z 

Fragmentation of the backbone at two sites gives rise to internal fragments. Usually, 
these are formed by a combination of b-type and y-type cleavage to produce the 
illustrated structure, amino-acylium ion. Sometimes, internal ions can be formed by a 
combination of a-type and y-type digest, an amino-immonium ion.  

An internal fragment with just a single side chain formed by a combination of a type 
and y type digest is called an immonium ion. The immonium ions can be used for 
DeNovo sequencing. The values from the following table are used to find these ions.  

 

  
Figure 3-4 Peptide Fragmentation 
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Residue 3-letter 
code 

1-letter 
code 

Immonium 
ion 

Related ions 

Alanine Ala A 44    

Cysteine Cys C 76    

Aspartic acid Asp D 88    

Glutamic acid Glu E 102    

Phenylalanine Phe F 120 148 

Glycine Gly G 30    

Histidine His H 110 82  155 

Isoleucine Ile I 86 44  72 

Lysine Lys K 101 84 

Leucine Leu L 86 44  72 

Methionine Met M 104 60 

Asparagine Asn N 87    

Proline Pro P 70 98 

Glutamine Gln Q 76    

Arginine Arg R 112 100  87  70  60 

Serine Ser S 60    

Threonine Thr T 74    

Valine Val V 72    

Tryptophan Trp W 159    

Tyrosine Tyr Y 136    

 

Immonium and related ion masses: 
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Figure 3-5 Fragmentation pattern for peptides 
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Figure 3-6 Structures of the fragments 
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3.3 Toolbar Reference and Shortcut List for 
BioTools 

To hide or display the toolbar, choose menu View - Toolbar.  

The toolbar can be dragged using the mouse. Click with the left mouse button on the 
background of the toolbar and move the toolbar with the mouse button pressed to the 
desired position.  

 
Toolbar  
button 

Menu option Shortcut /  
Function key 

Description 

  
File – Open Spectrum  Ctrl + O  Opens a file open dialog.   

  
File – Close All   Closes all opened data sets.  

 
File – Save Ctrl + S Saves the state of the active data file.  

  
File – Send  Sends the data file back to 

ProteinScape.  

  
File – Find   Opens a file manager for easier data 

handling and finding.  

  
File – Print   Prints the active data file immediately 

in accordance to the Print Setup.  

  
File – Print Preview   Shows a preview for controlling further 

printing.  

  
Edit – Cut Ctrl + X Deletes and copies into clipboard.  

  
Edit – Copy Ctrl + C Copies from clipboard to cursor 

position.  

  
Edit – Paste Ctrl + V Pastes from clipboard to cursor 

position. 
 

  
Figure 3-7 Toolbar of BioTools 
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Toolbar  
button 

Menu option Shortcut /  
Function key 

Description 

  
View – Activate MS view  F4 toggle  Changes the view of the sequence in 

the Fragments window to MS view.  

  
View – Activate MS/MS view  F4 toggle Changes the view of the sequence in 

the Fragments window to MS/MS 
view.  

  
Analysis – Annotation 
Parameter  

- Opens the annotation options dialog 
box.  

  
Search – Search Mass One 
Protein SequenceEditor  

- Opens the Search for mass dialog box 
in SequenceEditor (Search – Mass 
Search). 

 
Search –Digest 
SequenceEditor  

- Opens the Perform Digest dialog box 
in the SequenceEditor (Search – 
Perform Digest). 

  
Search – Mascot Peptide 
Mass Fingerprint 

- Opens the internet search via  
Peptide Mass Fingerprint.  

 
Search – Mascot Sequence 
Query  

- Opens the internet search via  
Sequence Query.  

 Search – Mascot MS/MS Ion 
Search  

- Opens the internet search via  
MS/MS Ion Search.  

  
Window – Show/Hide 
Treeview  

- Show or hide the Treeview window.  

 
Window – Show/Hide 
Fragments  

- Show or hide the Fragments window.  

  
View – Undo zooming - The previous zoom action is undon.e  

  
View – Redo zooming - The previous zoom action is redone. 

  Search – Mascot Batch  - Opens the Mascot Batch Mode 
window. 

  
Window – Start 
SequenceEditor  

- Loads a sequence into the Sequence 
Editor and starts this program  

  
Tools – Open Analysis in 
flexAnalysis 

 This menu option starts the program 
flexAnalysis for TOF data. 

  
Tools – Open Analysis in 
DataAnalysis 

 This menu option starts the program 
DataAnalysis for ion trap data. 

 
Help – About BioTools  -  Opens About BioTools window.  

  
Compass –  
Lock All Applications  

Ctrl + Alt + K All applications will be locked and can 
only be unlocked be a certified user.  
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Toolbar  
button 

Menu option Shortcut /  
Function key 

Description 

  
File –  
Sign Electronic Record  

 The active data file can be sign by a 
certified operator to the electronic 
record.  

  
File – Audit Trail   The file of the audit trail can be 

reviewed.   
 File – Print  Ctrl + P  Opens the printer dialog.  
 File – Exit Alt + F4 Terminates the program.  
 Analysis – Edit Peaks  Ctrl  The editing of peaks is permanent 

switched on. A click with RMB in the 
Spectrum window ends this function.  

 Help – Topics  F1 Opens the BioTools Online Help.  
    
 Special short keys for 

handling the zoomed area in 
the Spectrum window: 

F9 The extracted area is zoomed in.  
 F10 The extracted area is zoomed out. 
 F11 The extracted area is moved right. 
 F12 The extracted area is moved left. 
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3.4 Toolbar Reference and Shortcut List for 
SequenceEditor 

To hide or display the Toolbar, choose menu View - Toolbar.  

  
Figure 3-8 Toolbar of SequenceEditor 
 

If at least one sequence is opened, this feature is focused to the top toolbar of the 
sequence window.  

 
Toolbar  
button 

Menu option Shortcut/ 
Function key 

Description 

  
File – New Sequence  Ctrl + N  Creates a new sequence, also from the web.  

  
File – Save Ctrl + S Saves the active sequence with its current 

name.  If you have not named the sequence, 
your SequenceEditor displays the Save As 
dialog box. 

  
File –  
Append To Document 

 This appends the currently active sequence 
to the .sqs file it is based on. 
This button is the inverse of the "Delete 
Sequence" context menu available in the 
treeview and can be used to manage the 
contents of .sqs files flexibly. 

  
Edit – Cut Ctrl + X Removes selected data from the sequence 

and stores it on the clipboard. 

  
Edit – Copy Ctrl + C Copies the selection to the clipboard. 

  
Edit – Paste Ctrl + V Inserts the contents of the clipboard at the 

insertion point. 

  
-   The modified sequence or a marked range 

of it will be sent to BioTools for further 
processing.  

  
-   Prints the active data file immediately.  

  
Help – About 
SequenceEditor…  

 Opens About SequenceEditor window.  

  
-   Activates the context sensitive help. 
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Toolbar  
button 

Menu option Shortcut/ 
Function key 

Description 

  
Compass –  
Lock All Applications  

Ctrl + Alt + K All applications will be locked and can only 
be unlocked be a certified user.  

  
File – Sign Electronic 
Record  

 The active data file can be sign by a certified 
operator to the electronic record  

  
File – View Signatures   Opens the View Signatures dialog.  

  
File – Audit Trail   The file of the audit trail can be reviewed.   

 File – Print  Ctrl + P  Opens the printer dialog.  
 File – Exit Alt + F4 Terminates the program.  

 

 
3.5 Part Numbers  

# 1838877  Software-Package BioTools 3.2 SR5 

# 8256590 License BioTools 3.2   

# 8256591 License RapiDeNovo Sequencing  

# 8256589 BioTools 3.2 User Manual  
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